
DIAdemTM

Getting Started with DIAdem

Getting Started with DIAdem

July 2002 Edition
Part Number 323422A-01



Support

Worldwide Technical Support and Product Information

ni.com

National Instruments Corporate Headquarters

11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100

Worldwide Offices

Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20, Brazil 011 3262 3599,
Canada (Calgary) 403 274 9391, Canada (Montreal) 514 288 5722, Canada (Ottawa) 613 233 5949,
Canada (Québec) 514 694 8521, Canada (Toronto) 905 785 0085, China 86 21 6555 7838,
Czech Republic 02 2423 5774, Denmark 45 76 26 00, Finland 09 725 725 11, France 01 48 14 24 24,
Germany 089 741 31 30, Greece 01 42 96 427, Hong Kong 2645 3186, India 91 80 4190000,
Israel 03 6393737, Italy 02 413091, Japan 03 5472 2970, Korea 02 3451 3400, Malaysia 603 9596711,
Mexico 001 800 010 0793, Netherlands 0348 433466, New Zealand 09 914 0488, Norway 32 27 73 00,
Poland 22 3390 150, Portugal 210 311 210, Russia 095 238 7139, Singapore 65 6 226 5886,
Slovenia 3 425 4200, South Africa 11 805 8197, Spain 91 640 0085, Sweden 08 587 895 00,
Switzerland 056 200 51 51, Taiwan 02 2528 7227, United Kingdom 01635 523545

For further support information, see the Technical Support and Professional Services appendix. To comment on
the documentation, send email to techpubs@ni.com.

© 2002 National Instruments (Ireland) Limited. All rights reserved.



Important Information

Warranty
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A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before
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National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent
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Copyright
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Patents
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Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes
parameter names.

italic Italic text denotes variables, emphasis, or a cross reference.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.

monospace bold Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.
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1
DIAdem

National Instruments DIAdem gives you functions for performing tasks
with technical data. DIAdem has modules for data management,
mathematical and graphical data analysis, and for generating professional
test reports. You can automate all the DIAdem functions in Autosequences
with Visual Basic Script.

The DIAdem Modules
DIAdem is modular. You can purchase DIAdem with the modules and
toolsets you need for your tasks.

DIAdem DATA is for managing and editing your data and can process large
amounts of data, with over two billion values. DIAdem can exchange data
with other programs like NI LabVIEW or Microsoft Excel, and read and
save data in ASCII or binary format. DIAdem communicates with
databases using Microsoft ADO, SQL/ODBC, or ASAM/ODS.

DIAdem VIEW offers you functions for graphically analyzing and viewing
data. With various kinds of graphics cursors you can measure graphs and
graphically extract data areas and copy them into new data channels.

DIAdem CALC provides a wide range of options for mathematical data
analysis. From simple channel calculations, through statistics, signal and
curve analysis, to crash test analysis, DIAdem CALC provides engineers
and scientists with mathematical solutions.

DIAdem GRAPH is the module for generating flexible, reusable test
reports, that include any combinations of 2D and 3D axis systems, polar
displays, tables, and texts with variables. By using variables, and storing
layouts and data separately, you can reuse your layouts any number of
times.

DIAdem AUTO automates recurring sequences. With the Visual Basic
Script language used in DIAdem, you modify the user interface and include
your own functions in the program. Automate your recurring sequences
from data import, through mathematical analysis, to printing your
evaluations.
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When working with video sequences or 3D models, you can extend
DIAdem to include the external modules DIAdem CLIP or DIAdem
INSIGHT.

DIAdem CLIP analyzes measured values and videos that you acquired
simultaneously from one test. Run videos and measured values
synchronously or click any measured value in the graph display to view
the related video frame.

DIAdem INSIGHT projects measured data onto a model of your
measurement object as color shading or deformation. You link the
measurement signals to the point on the model where you acquired the data.

The DIAdem Screen
As you see in Figure 1-1, the DIAdem modules are always on the left of the
screen. If you switch among the modules, the functions in the toolbars and
function bars change.

Figure 1-1. DIAdem GRAPH Overview

1 DIAdem modules
2 Overview of all the function bars in a module
3 Open function bar

4 Toolbar
5 Workspace

1 2 3 4 5



Chapter 1 DIAdem

© National Instruments (Ireland) Limited 1-3 Getting Started with DIAdem

Note You can start a variety of examples from the DIAdem Help. You access the examples
by clicking Help»Examples. If you have not installed the examples, you can do so with a
user-defined installation.
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2
Generating Your First Report

The Report Wizard appears when you launch DIAdem and when you click
File New in DIAdem DATA and DIAdem GRAPH. Use the Report Wizard
to generate a report in three steps:

1. Selecting data

2. Defining graphs

3. Selecting a layout

You can move back and forth among the three steps to change your settings.
You can finish your report at each step. DIAdem uses standard settings for
steps you leave out.

Selecting Data
To select data, specify the data source that has the data you want to load,
as shown in Figure 2-1.

Figure 2-1. Selecting Data for the Report
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The simplest type of data source is a directory with data files. The My
Computer data source provides all the directories on your PC. Use Source
definition to extend the list of available data sources.

1. Select one of the following data sources:

• Files

• Citadel databases

• VI Logger

• SQL databases

• AOP databases

• ATF files

2. Enter the file extensions of the desired files:

• DIAdem data (*.DAT)

• ASCII data (*.ASC, *.TXT)

• Excel data (*.XLS)

• LabVIEW data (*.LVM, *.TXT)

• ASAM data (*.ATF)

3. Click Apply to refresh the tree.

Defining Graphs
To define graphs, the Report Wizard analyzes the data set, and recognizes
time and frequency channels as x-channels. The Report Wizard assigns
these x-channels to the other channels as shown in Figure 2-2. Select
one row in this graph overview and assign a different x-channel to change
the suggested channel combination. Disable graphs that you do not want to
display in the Use column.
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Figure 2-2. Specifying X- and Y-Channel Pairs for the Graph Definition

Selecting a Layout
You can select a layout for your graph, as shown in Figure 2-3.

1. To select a layout, choose one of the following:

• Y-axes—Displays several graphs with the same x-axis in one axis
system with several y-axes in DIAdem GRAPH.

• Tile—Displays each graph in its own axis system in DIAdem
GRAPH.

• VIEW—Displays the graphs in DIAdem VIEW.
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Figure 2-3. Selecting a Layout for the Graph Display

2. Click Finish to generate your report. The Report Wizard generates the
report automatically.
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Figure 2-4. Example of an Automatically Generated Report

Note To disable the Report Wizard, select Settings»Desktop parameters»General»
Report Wizard.
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3
Loading and Managing Data
with DIAdem DATA

DIAdem DATA helps you process and manage data and load and view
your data.

The amount of data one channel can contain is virtually unlimited. Several
thousand channels of data can be handled and processed simultaneously
(a theoretical maximum 65,536 channels with more than 2 billion values).

Tip For further information, press <F1> while in DIAdem DATA.

DIAdem and Other Data Formats
DIAdem can read data files from office applications, ASCII, and various
binary formats. DIAdem also functions with NI LabVIEW, which has VIs
that write the DIAdem native data file format for easy data exchange.
With DIAdem, you can also connect to databases using the SQL/ODBC
or the ASAM standards. You can create DLLs for DIAdem to import
customer-specific data files into the program as well. These DLLs can be
created using the DLL toolkit included with DIAdem or using a pre-built
one from NI Consulting Services or an NI Alliance Partner.
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Working with DIAdem DATA
Now you can explore the different aspects of the DIAdem DATA module.

1. Click DIAdem DATA.

2. Click Load Data at the top of the screen, as shown in Figure 3-1.

3. Choose the data set Data2.DAT.

The channel names Time and Sound in Figure 3-1 represent the signal from
one sensor of the measurement or the result of a calculation performed in
DIAdem.

Figure 3-1. DIAdem DATA Channel Overview Screen

1 Delete data 2 Load data

1 2
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Viewing Individual Channel Contents
With DIAdem DATA, you can see and edit individual data points. The
Channel attributes section of the Channel contents screen shows the header
information, as shown in Figure 3-2, of each individual channel, such as the
channel name, comments, and unit of measurement.

Click the Channel contents tab at the bottom of your screen to view this
information.

Figure 3-2. DIAdem DATA Channel Contents Screen

Experimenting with Your Data without Risk
DIAdem does not assign formulas to individual cells. Also, it will not
automatically change the contents of a cell when other data in this view
is modified. This helps avoid accidental modifications to your data and
results.

If you process or modify the data file currently loaded, it affects only the
data in the memory, not the source file from which the data was loaded.
DIAdem also inserts your new data in a separate data channel. So, with
DIAdem you can experiment with your data without worrying about the
risks of destroying the original file.
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4
Viewing Data Interactively
with DIAdem VIEW

With DIAdem VIEW, you view and analyze data graphically in predefined
screen layouts. DIAdem VIEW is mainly for viewing your data quickly.
DIAdem GRAPH is a more powerful module for creating reports.

Figure 4-1. DIAdem VIEW Overview

Tip For further information, press <F1> while in DIAdem VIEW.

1 Hard copy
2 Cursor types
3 Cursor modes

4 Screen partitioning formats
5 Zoom tools

6 Graph icon
7 Upper axis system

1 2 3 6

7

4

5



Chapter 4 Viewing Data Interactively with DIAdem VIEW

Getting Started with DIAdem 4-2 ni.com

Defining a Graph
Try viewing some sound frequency data with DIAdem VIEW:

1. Click DIAdem VIEW.

2. Select the first icon from the Screen partitioning bar as shown in
Figure 4-1.

3. Select the Two axis systems icon (the second icon on the toolbar) that
gives you two full width windows.

4. Double-click inside the top axis system window of DIAdem VIEW.
This opens the Graph definition dialog box that allows you to
configure the data that can be displayed in it.

Each xy set of data channels appears as a line in this dialog box. It also
displays the color that each of the xy channels will be displayed in.
Each window in DIAdem VIEW can display up to 20 xy channel
combinations.

5. Select New entry to add a graph to the display.

6. From the resulting New graph definition dialog box, shown in
Figure 4-2, select Time as x- and Sound as y-channel, and select the
color black at the bottom of the dialog. If multiple y channels are
selected, each channel will automatically receive a new color if the box
Count color up automatically is checked.

Figure 4-2. New Graph Definition Dialog Box
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7. Select OK on both dialog boxes. Figure 4-3 shows the results of the
exercise.

Figure 4-3. Visual Results of Data in DIAdem VIEW

Analyzing Data with Graph Cursors
DIAdem VIEW provides a variety of graph cursors and graph modes to
analyze your data. With graph cursors, you can scroll along a graph and
analyze individual values. You can also use graph cursors to locate minima
and maxima within a graph.

Other features in DIAdem VIEW allow you to concentrate on specific
portions of data. You can zoom in on specific areas of data and even
drag and drop them into different graphs. The x- and y-values of the cursor
location appear in the lower left corner of the screen. When using the cursor
mode, DIAdem VIEW also displays the row in the data table for individual
data points in the axis system along with the x- and y-values of the cursor
location.
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Selecting the Cursor Mode
The buttons in Figure 4-4 let you select the cursor mode.

Figure 4-4. Cursor Modes

The first icon in Figure 4-4 is the Free cursor and is the default cursor mode.
In this mode, the cursor can be moved anywhere within the window.

The second cursor mode is the Graph cursor. In this mode, a crosshair
follows the graph and displays the data values of the graph.

The last two cursor modes locate Minimum peaks and Maximum peaks.
These cursors jump from local minimum to local minimum or local
maximum to local maximum.

With the Free cursor, you can move the x- and y-axes of the Free cursor
independently along the x- and y-axes of the graph.

1. Select the Free cursor. As you move your mouse cursor over the
x- and y-axes, arrows appear indicating the directions you can move
the cursor.

2. Click the y-axis Free cursor and move it up and down.

3. As you move the Free cursor along the y-axis, notice that at the
bottom of the screen, values for y change.

You can use the Graph cursor to follow the specific values of a curve in a
graph.

1. Select the Graph cursor.

2. Move your mouse cursor over the Graph cursor axes or on the
crosshairs of the Graph cursor. Arrows appear indicating the
directions you can move the cursor.

3. Click and drag the mouse cursor over the crosshairs of the Graph
cursor along the graph. As you move the Graph cursor, the x- and
y-values displayed at the bottom of the screen show their location
along the x- and y-axes.

1 Free cursor
2 Graph cursor

3 Maximum peaks
4 Minimum peaks

1 2 3 4
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Creating a New View
Creating a view in another window requires either double-clicking on an
axis system window or dragging and dropping an existing graph into the
new view.

1. Using the mouse cursor, select the Graph icon, as shown in
Figure 4-1, located in the legend at the right of the top graph.

2. Drag and drop the selected Graph icon into the lower window.

Notice the graph of the channel Sound appears in the bottom window, too.

Toggling Cursor Types
The three icons in Figure 4-5 represent different cursor types.

Figure 4-5. Cursor Types

The icon with perpendicular lines selects the Crosshair cursor, the icon with
parallel lines selects the Band cursor, and the icon that looks like a # selects
the Frame cursor.

Using the Band and Frame cursors, you can display and analyze specific
parts of your data.

Try adjusting the cursor to look at a specific section of the graph.

1. Select the Band cursor icon.

2. Adjust the width of the band by moving the mouse cursor over one
of the Band cursor elements. The cursor changes to a double-sided
arrow.

As you change the data displayed in the lower window, the numerical
values in the bottom left part of the screen reflect the values of the main
graph, as well as those of your new view.

1 Crosshair cursor 2 Band cursor 3 Frame cursor

1 2 3
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Creating Detailed Views
Now that you have adjusted the size of the band, you can adjust and zoom
in on the graph to create a more detailed view.

Figure 4-6. Zoom Features

In the lower window, which displays the same graph, a set of icons like
those in Figure 4-6 allows you to zoom in or scroll along the graph within
a specific range.

1. Select the Scroll on/off icon (the magnifying glass with the arrow
pointing left and right). The lower window will only display the range
of data contained within the band in the window view.

2. Move the Band cursor in the top window. Then, click and drag your
mouse cursor over the crosshairs of the graph cursor to the segment of
the graph that you want to focus on.

3. Drag and drop the Band cursor to select a portion of the graph that you
want to examine in closer detail. Figure 4-7 shows the magnified
portion of the graph.

1 Zoom 2 Zoom back 3 Scroll on/off

1 2 3
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Figure 4-7. Magnified Graph

Displaying Legend Information in DIAdem VIEW
For each graph you create, DIAdem VIEW automatically generates a
legend that labels the name, units, coordinates, and graphs of your data
views.

1. Move the mouse cursor in the top window to the right border of the
graph window.

As you move the mouse cursor over the right edge of the graph, it will
change to a symbol of a two-way arrow bracketing a set of parallel
lines.

2. Click your mouse button on the right edge.

3. Drag out the legend by moving your mouse to the left.

You can also configure the legend for your graph. By default it already
displays the name, unit, and xy values of each channel displayed in the
graph window. Figure 4-8 shows DIAdem VIEW displaying legend
information.
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Figure 4-8. Legend Information
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5
Applying Mathematical
Functions with DIAdem CALC

With DIAdem CALC, you apply predefined mathematical functions,
including basic math, curve fitting functions, signal analysis, and statistics.
Each icon expands to display an icon bar representing the different
functions available for data processing.

Figure 5-1. DIAdem CALC Overview

Tip Holding the mouse cursor over the icons will give you Tool Tips, which briefly
explain the functions assigned to each individual icon.

Tip For further information, press <F1> while in DIAdem CALC.

1 Mathematical function bar 2 Calculation comment field

2

1
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Using Mathematical Functions
With DIAdem CALC, you can perform mathematical functions on your
data. Using dialog boxes, you can choose which parameters to use and
which channels to analyze.

1. Click DIAdem CALC.

2. Select the Basic mathematics icon from the Mathematical Function
bar.

3. Select the Root Mean Square (RMS) function.

Figure 5-2. RMS Values Dialog Box

4. Choose 1 Time for the x-channel; choose 2 Sound for the y-channel.

5. Enter 5 for the Calculation parameters.

6. Click Execute.

Note After you click Execute, DIAdem displays a message informing you that the
calculation is complete. Because the example waveform is irregular, DIAdem CALC
informs you that the channel values are not equidistant.
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The RMS Values dialog box in Figure 5-2 represents an example of the
interface for the mathematical functions available in DIAdem CALC.
By simply selecting parameters, you can process the data. This particular
dialog has the following three parameters:

• data channel to be processed

• parameter for the mathematical function (in this case the interval
width)

• way the result will be stored

You can either store it in a new channel or replace the original data
channel by overwriting it. By default, the data will be put into a new
channel.

The RMS function approximately calculates floating square integral mean
values. This means that a window with a determined interval width is
moved along a specified graph. For each point, the integral is calculated
over the corresponding interval. If the specified interval width corresponds
exactly to a period of time, then the resulting data likewise corresponds to
the RMS values of the signal.

The interval width of the RMS calculation, specified as a percentage of the
channel length, determines the number of values to the right and left of the
data point that are used for the integral calculation.

Displaying Calculation Results
Switch to DIAdem DATA. To view the Y-root_mean channel results for
the RMS calculation you just made, click DIAdem DATA.

A new data channel with the results from the RMS math function has been
added to the data overview. The comment for that data channel refers to the
data channels that were used in the calculation.

Caution DIAdem creates a new data channel each time a math function is executed, unless
the Store result in original channel box is selected. This is also the case if the function
only returns a single value as a result, as happens with some statistics functions like
standard deviation.
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Figure 5-3 shows the new data channel created.

Note In DIAdem, when a new data channel is created, the comment field in DIAdem
DATA indicates the number of channels involved in the calculation, as is the case in
Figure 5-3. For example, Time and Sound were the input parameters for the
Y_root_mean channel.

Figure 5-3. Results of Channel Creation in DIAdem DATA
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6
Creating Reports with
DIAdem GRAPH

With DIAdem GRAPH, you create vivid reports for your data. Different
objects can be added to a page in DIAdem GRAPH, including
two-dimensional and three-dimensional axis systems and tables, polar
coordinate plots, texts and variables, as well as graphics files. With
DIAdem GRAPH, you can make colorful, informative reports and
presentations.

Tip For further information, press <F1> while in DIAdem GRAPH.

Note Do not save any changes to the data files (.DAT) in this chapter. Later sections of this
manual require the original data files.

Creating a New Layout
A default layout appears after you select DIAdem GRAPH. You can delete
this layout to start with a blank screen.

1. Click DIAdem GRAPH.

2. Click the Delete picture definition button in the upper left-hand
corner of the screen as shown in Figure 6-1. Alternatively, choose
File»New from the menu.

You now have a blank, landscape-format page in front of you.

Choosing a Graph Layout
The icon bar on the left side of the DIAdem GRAPH screen lists the various
objects available. Each icon represents a group of functions and allows
access to a set of pre-defined objects that you can modify. For example,
the two-dimensional axis system templates include predefined axis
systems with logarithmic scaling or with multiple y-axes.
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1. Select the 2D axis system from the object bar.

2. Choose the fifth icon from the 2D axis system templates.

3. Size the graph by dragging any of the small square blocks on the edges
of the graph with your mouse cursor.

4. Extend the axis system on your screen to the full width of DIAdem
GRAPH.

In Figure 6-1, you see the layout that you just completed.

Figure 6-1. DIAdem GRAPH Overview

Tip You can also move and position most objects in DIAdem GRAPH by placing your
mouse cursor over them and dragging and dropping them where you want them to be. This
includes text, graph elements, and graphics.

1 Graphics
2 Delete picture definition
3 Load picture definition

4 Save picture definition
5 2D axis system

6 Text
7 Redraw

4 5 6 7

2

3

1
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Adding Data to an Axis System
You add data to an axis system in DIAdem GRAPH the same way you add
it to a DIAdem VIEW window—simply double-click in the axis system.
DIAdem GRAPH offers more features than DIAdem VIEW to customize
the appearance of your reports. For example, you can display data in bar
graphs, add constants, and add a legend to your graph to provide additional
information.

1. Double-click inside the axis system.

2. Select the New entry button inside the Graph and axis definition
dialog box.

3. Select channel 2 in the New graph definition dialog box to the graph,
using channel 1 as the x-axis. Click OK.

4. Select the New entry button.

5. Select channel 3, using channel 1 as the x-axis. Click OK.

6. Click OK.

Adding Graphics to Your Layout
Up to 80 axis systems can be put onto a page, and each axis system can
accommodate more than 120 graphs. You can also personalize your layouts
with company logos. DIAdem supports a number of different graphics
formats including GIF, JPEG, and TIFF.

Add a graphic to your layout.

1. Click the Graphics button shown in Figure 6-1.

2. Then, click the Load background graphics button.

3. Choose ...\DIADEM\Libr\gra\example1.wmf, and click OK.
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Figure 6-2. Selecting a Graphic.

The resulting graph in Figure 6-3 shows how your graph should appear.
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Figure 6-3. Adding a Graphic to a Layout

Labelling Your Report
You can also add text to your graphs. Use DIAdem variables such as
the date, time, and data file name to update the text of your layout
automatically. It is also possible to add information such as the minimum
or maximum value of a data set or any other information that is stored in a
DIAdem variable.

You can now add text to the diagram explaining the information shown on
the report.

1. Click the Text (A) button on the toolbar on top of the screen as shown
in Figure 6-1. The cursor changes to the text mode.

2. Click the position on the screen where you want to add your text input.

3. Enter the following text: Data file name: @DatFile@ and press
<Enter>.
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4. Click the Text button and enter a second line of text: Report date: 
@CurrDate@ and press <Enter>.

5. Click the Text button and enter a third line of text: Maximum value: 
@Cmax(‘Sound’)@ and press <Enter>.

6. To limit the values after the decimal place, double-click that text and
edit the input in the Texts dialog box as shown in Figure 6-4.

Figure 6-4. Text Formatting Dialog Box

7. Edit the text to read as follows:

Maximum value: @str(Cmax(’Sound’),’d.dd’)@
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This rounds the maximum value of the Sound channel with two decimal
places behind the decimal point as Figure 6-5 shows.

Figure 6-5. Adding Text to a Layout

Making a Template
Assume this is the layout you want to use for all your other reports. Here is
how you can apply the template to other data sets.

1. Select the Save as icon from the toolbar to store this layout template.

2. Enter the filename Template1.LPD and click Save. After storing the
template, you can use it with any data file that has a similar structure.
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7
Automating Tasks with
DIAdem AUTO

With DIAdem AUTO, you can automate sequences of commands and put
them into an Autosequence. An Autosequence is basically a macro that
you can extend to include programming structures, user-defined variables,
and dialogs.

Figure 7-1. DIAdem AUTO Overview

Creating an Autosequence
In order to create an Autosequence, you just have to start recording.
As you perform the various tasks using different DIAdem modules,
DIAdem encodes your actions using Visual Basic Script (VBS).

1 New file
2 Save file as
3 Execute file

4 Enable record mode
5 Disable record mode

6 Execute VBS Autosequences
7 Editor window

2 5

1

6 73 4
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1. Click DIAdem AUTO.

2. Click the Autosequence Record on icon to start recording the
Autosequence.

DIAdem AUTO prompts you to enter the Autosequence author and
comments. It places these items directly into the Autosequence code to
help you identify it in the future.

In the Recording additions dialog box, you can enter the author name and
make brief comments about an Autosequence, as shown in Figure 7-2.

3. Enter the Author and any Comments.

4. Choose VBS - Autosequence for the template type.

5. Click OK.

Figure 7-2. Documenting Recording Additions in Autosequences

Recording Your Autosequence
After you click OK in the Recording additions dialog box, notice that a
Record on symbol appears at the bottom of the screen. This indicates
that you have successfully started recording your Autosequence. Every
DIAdem function you perform while the green dot displays in the status
bar will be recorded in the Autosequence file.
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The text editor appearing on the right part of the screen displays header
information and code for your Autosequence. Notice in the header, the
information that you entered in the Recording additions dialog box
appears in the Autosquence code.

Now perform the following exercises. The Autosequence records them
during the Teach-In mode.

1. Click DIAdem DATA.

2. Click the Delete data icon to clear DIAdem DATA. If prompted to
save changes to the data, choose No.

3. Click the Load data icon.

4. Choose the data set Data2.DAT, and click Open.

5. Click DIAdem CALC.

6. Click the Basic mathematics icon, then click the Root Mean
Square calculation icon.

7. Set the RMS Values (Channel 1, Time; Channel 2, Sound;
Calculation parameters, 5), and click the Execute button.

8. Click DIAdem GRAPH.

9. Click the Delete picture definition icon. Do not save changes to
the data.

10. Click the Load picture definition icon. Select the layout you created
in DIAdem GRAPH exercise called Template1.LPD. The screen
automatically updates to show the data set you have just loaded.

11. Click DIAdem AUTO.

12. Click the Autosequence record off icon.

13. Click the Save file as button. Enter the name Auto.VBS.
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Running an Autosequence
Now that you recorded an Autosequence, test its results.

Click the Execute VBS - Autosequence icon.

As soon as the Autosequence starts running, it performs all the actions
you performed during the Teach-In mode.

Autosequence Code
After recording an Autosequence, DIAdem AUTO displays the
Autosequence code. You can change the code directly in the text editor.
Here is the code from the Autosequence you just created.

------------------------------------------------------

-- VBS - Autosequence - File

-- Created 07/30/2001 11:42:16

-- Author: DIAdem User

-- Comment: My First Autosequence

------------------------------------------------------

Call DATADELALL(1)                      '... HEADERDEL

Call DATALOAD("Data2")                  '... DATAFILE

Call CHNRMS("Time","Sound","Y_root_mean",10) '... X,Y,E,RMSWIDTH 

Call PICDELETE()

Call PICLOAD("template1")               '... PICFILE 

Call PICUPDATE()

The code contains automatically generated comments enclosed in brackets
as well as commands and parameters. Your Autosequence contains six lines
of code.

• DATADELALL() deletes all the data currently contained in the DIAdem
data matrix.

• The DATALOAD() command loads the data file. In the example, it has
a fixed parameter, which you will learn how to change in order to make
this Autosequence useful for loading other data files.

• The CHNRMS() command creates a new data channel that contains the
root mean square of your original data.

• The PICDELETE command deletes the default layout.

• The PICLOAD() command loads a layout.

• The PICUPDATE() command ensures that this layout is filled with the
current data and updated correctly.
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Editing Autosequence Code
Now you can edit this Autosequence to make it work with any data set.

1. Insert a line with a new command after the DATADELALL command:

Call FileNameGet(“DATA”,”FileRead”)

FileNameGet() opens a standard Windows dialog for loading or
saving files. The parameter DATA tells the software to look only for
DIAdem data files (in contrast to all files such as a layout definition).
The parameter FileRead lets the software know to load the file. Make
sure to include Call with each command to let DIAdem know a new
line has started.

2. Edit the DATALOAD(“FileName”) command to include the variable
that will contain the file name selected in the FileNameGet
command. The variable is called FileDlgFile. This is how the line
should look after you have modified it:

Call DATALOAD(FileDlgFile)

3. Save your new Autosequence and select the same name, Auto.VBS.

Here is the Autosequence you changed:

--------------------------------------------------

-- VBS - Autosequence - File

-- Created on 07/30/2001 11:42:16

-- Author: DIAdem User

-- Comments: My First Autosequence

--------------------------------------------------

Call DATADELALL(1)                      '... HEADERDEL

Call FileNameGet("Data","FileRead")

Call DATALOAD(FileDlgFile)                  '... DATAFILE 

Call CHNRMS("Time","Sound","Y_root_mean",10) '... X,Y,E,RMSWIDTH 

Call PICDELETE()

Call PICLOAD("template1")               '... PICFILE

Call PICUPDATE()

Tip For more information about specific commands, press <F1> to access the DIAdem
Help. Using the index or search feature, you can find detailed information about special
commands to use in your Autosequences.
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Testing Your New Autosequence
1. Run the modified Autosequence by clicking the Execute File icon.

2. Select Auto.VBS. As soon as the Autosequence starts running,
a dialog box appears and prompts you to select a data file.

3. Select Data3.DAT. The Autosequence will automatically calculate
the root mean square and bring up the final report with all relevant
information.

Additional Autosequence Capabilities
Your Autosequences can also contain commands to send your report to a
printer, to a graphics file, or to the clipboard to insert it into other programs.

Autosequences can also include programming commands such as
IF..THEN..ELSE, WHILE..DO, REPEAT..UNTIL, or CASE..OF..ELSE.
Autosequences can be used to automatically detect events in data sets and
react to these by branching out into different subroutines of an
Autosequence. DIAdem also provides functions for creating user
interfaces, custom dialog boxes, and variables.
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8
Evaluating Data and Videos
with DIAdem CLIP

With DIAdem CLIP, you can simultaneously analyze test data and videos
you have recorded. In DIAdem CLIP scenes, you combine video windows
with axis systems that display measurement data in graphs.

Figure 8-1. DIAdem CLIP Overview

1 Console for running sequences
2 Setting the playback speed
3 Time stamp for current videos

4 Data overview
5 Axis system
6 Video window
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3



Chapter 8 Evaluating Data and Videos with DIAdem CLIP

Getting Started with DIAdem 8-2 ni.com

Note DIAdem CLIP is an external module you must install separately.

Generating Scenes with Videos
All the available data types are in the data overview on the right of the
DIAdem CLIP screen. In the workspace on the left, you create scenes using
videos, DIAdem data, and axis systems.

1. Start DIAdem CLIP.

A prepared layout appears in the workspace with two video windows
and one axis system.

2. Select the Videos tab in the data overview.

3. Drag and drop the sidecrash1.AVI video to the left video window.

4. Drag and drop the sidecrash2.AVI video to the right video window.

The two recordings show a crash test from two different angles.

5. Select the DIAdem Data tab in the data overview.

6. Click the + to open the sidecrash data set.

7. Click a data channel. If you want to select more data channels, press
<Ctrl>. A turquoise square with an arrow pointing to the axis system
appears in front of each data channel.

8. Insert the selected data channels in the axis system. Figure 8-2 displays
the scene.
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Figure 8-2. Two Different Videos and Measurement Data from a Crash Test

Note Click the object frame to move the video window and the axis system. Use the
corner markers to zoom the window in and out.

Evaluating Videos
Once you have created the scene, you can compare the measurement data
and the videos. DIAdem CLIP offers two ways to perform your evaluation:

• Automatically—using the player bar. By running through the complete
time channel, you get an overview of the test.

• Manually—using the crosshair cursor in the axis system. You can
move from point to point in your graph to check critical or unclear
ranges. DIAdem CLIP shows the video pictures relating to each graph
point.
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1. Click Start in the player bar to run the whole evaluation.

2. For a detailed examination, click in the axis system and move the
crosshair cursor.

The axis system legend shows the measurement values you point to
with the crosshair cursor.

Tip You can use the legend to delete curves from the axis system. Click the appropriate
color square and press <Del>.
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9
Projecting Data onto Measurement
Objects with DIAdem INSIGHT

With DIAdem INSIGHT, you project your measurement data onto a model
of the measurement object. Link the measurement signals to the
corresponding point on the model where you acquired the data. You display
the measured values on the model as color shading or deformation.

Figure 9-1. DIAdem INSIGHT Overview

1 Console for running sequences
2 Setting the playback speed
3 Time stamp for current projection

4 Data overview
5 Graphics

6 Axis system
7 Model window
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Note DIAdem INSIGHT is an external module you must install separately.

Generating Scenes with 3D Models
You generate scenes as described in Chapter 8, Evaluating Data and
Videos with DIAdem CLIP. In addition to the video windows and axis
systems, DIAdem INSIGHT has model windows for projecting measured
data onto grid models. You can assign each model point to the data channel
you acquired at that point. You also specify whether the measured values
are displayed as color shading or deformation.

In the following exercise, you assign data for a metal plate with
28 temperature sensors mounted at regular intervals. Temperature sensors
measured the temperature as a lighter heated the metal plate and liquid
nitrogen cooled it.

1. Start DIAdem INSIGHT.

In the workspace, you see a prepared layout with a model window.

2. Select the Models tab in the data overview.

3. Drag and drop the plate.MOD model into the model window.

4. Select the DIAdem files tab in the data overview.

5. Click the + to open the plate1 data set.

6. Click a data channel and drag the data channel to a model point.

7. As soon as you release the mouse button, the dialog shown in
Figure 9-2 appears. Select Color.

Figure 9-2. Model Point Definition as Color Shading

8. Click OK.
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9. Connect other data channels to model points. Figure 9-3 displays the
scene.

Figure 9-3. Large Red Points Show Model Points with Assigned Data Channels

Evaluating 3D Models
Now that you have completed the scene, run the evaluation as described in
Chapter 8, Evaluating Data and Videos with DIAdem CLIP. You can
zoom, move, and rotate the model in the model window.

• Zoom the model with the right mouse button, moving the mouse
horizontally at the same time:
– Move the mouse to the right to enlarge the model
– Move the mouse to the left to reduce the model

• Move the model along the coordinate axis with the right mouse button,
pressing <x>, <y>, or <z> to specify the axis. You will see the
coordinate axes at the bottom right in the model window.
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• Rotate the model with the left mouse button:
– Move the mouse horizontally to rotate the model around the

vertical axis
– Move the mouse vertically to rotate the model around the

horizontal axis
– Move the mouse diagonally to rotate the model around both axes
– Move the mouse horizontally and press <x>, <y>, or <z> to rotate

the model around the x, y, or z coordinate axis
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A
Technical Support and
Professional Services

Visit the following sections of the National Instruments Web site at
ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions,
visit our extensive library of technical support resources available
in English, Japanese, and Spanish at ni.com/support. These
resources are available for most products at no cost to registered
users and include software drivers and updates, a KnowledgeBase,
product manuals, step-by-step troubleshooting wizards, hardware
schematics and conformity documentation, example code,
tutorials and application notes, instrument drivers, discussion
forums, a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other
measurement and automation professionals by visiting
ni.com/ask. Our online system helps you define your question
and connects you to the experts by phone, discussion forum,
or email.

• Training—Visit ni.com/custed for self-paced tutorials, videos, and
interactive CDs. You also can register for instructor-led, hands-on
courses at locations around the world.

• System Integration—If you have time constraints, limited in-house
technical resources, or other project challenges, NI Alliance Program
members can help. To learn more, call your local NI office or visit
ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact
your local office or NI corporate headquarters. Phone numbers for our
worldwide offices are listed at the front of this manual. You also can visit
the Worldwide Offices section of ni.com/niglobal to access the branch
office Web sites, which provide up-to-date contact information, support
phone numbers, email addresses, and current events.
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